# User Manual

## Table of Contents

**Getting Started**  
Welcome to BigTree!  
Glossary of Terms  
Iconography  

**Basic Usage**  
Overview  
Navigation  
Header  
Quick Links  

**Pages**  
Navigating Pages  
Adding Pages  
Navigation Tab  
Template Tab  
Content Tab  
Search Engine Optimization (SEO) Tab  

**Editing Pages**  
Archiving & Deleting Pages  
Moving & Reordering Pages  

**Detailed Usage**  
WYSIWYG  
Adding Text  
Text from External Sources  
Keystrokes & Mouse Tricks  

**Link Search**  
Adding Hyperlinks  

**Resources Toolbar**  
Upload a New Resource  
Find an Existing Resource  
Deleting Resources  
Adding Images  
Adding Documents  

**Notes**  

---

**Questions or Problems?**

Contact the Web Manager at 253.879.2691 or bweist@pugetsound.edu.

---

**Designed & Developed by Fastspot ©2009**
Getting Started

Welcome to BigTree!

Your BigTree Web Content Management Solution enables you, the content expert, to have control over your content without requiring previous knowledge or experience with HTML, Website Design, or Web Management.

BigTree uses the Firefox Web browser interface to provide you with the flexibility of adding and updating content to your site editor on-the-fly via templates, custom modules, and a WYSIWYG editor. (Note that Mac users have used Safari to access BigTree with success.)

BigTree is not a Web development or Web design tool. The look, feel and functionality of your Web site is administered via templates. If you would like to add new functionality to your site, please contact the Web Manager.

Glossary of Terms

cache  |ka sh|
A block of memory that is stored by your browser to help upload pages that it has already uploaded at a quicker speed. You should clear your cache in case you are having problems seeing any updates you have made to your site.

child page  |ch ĭlд pāj|
A page that has a parent page. The page below a specific page in the page tree is the child page of the page above it. For example:

- Parent Page (About Us)
  - Child Page 1 (Location)
    - Child Page 2 (Contact Info)

CMS

Content Management System; a system used to manage the content of a Web site.

content  |kɒntent|
An individual piece of content displayed on the Web site. It may consist of any or all of the following:

- Text
- Images
- Hyperlinks to other Web pages
- Links to download files

download  |dʌn lɔd|
To transfer data, files, or programs from a server to a local computer or device.
HTML
Hypertext Markup Language; this language is used to create World Wide Web pages, with hyperlinks and markup “tags” for text formatting such heading styles, bold, italic, numbered lists, insertion of images, etc..

hyperlink |hipər lɪŋ k|
A reference or navigation element in a document that links either to a different document (possibly on a different domain) or a specific spot on the current document.

live search |liv sɔr ch|
Type of search engine where the listing of search suggestions is shown in real time as queries are entered.

meta description |metə diskrip ʃən|
The Meta description tag is a snippet of HTML code that belongs inside the <Head> </Head> section of a Web page. The meta description tag is a concise, but richly descriptive summary of your page's content. It is designed to provide a brief description of your site which can be used by search engines or directories.

meta element |metə elemənt|
Meta elements are HTML or XHTML elements used to provide structured metadata about a Web page. Such elements must be placed as tags in the <head> section of an HTML or XHTML document. Meta elements can be used to specify page description, keywords and any other metadata not provided through the other head elements and attributes. See meta description and meta keyword.

meta keyword |metə kərəd|
A meta keywords tag is a brief and concise comma-separated list of the most important themes on a particular Web page.

module |mäjoōl|
A discrete set of functionality and presentation templates that manipulate and display data in a predefined manner.

• FAQs
• News
• Events Calendar

page |pāj|
A single Web page within the site that has a unique URL. A page may or may not be part of the main navigation.

parent page |par ənt pāj|
Refers to the page directly above another page in the navigation tree. For example:

• Parent Page (About Us)
  o Child Page 1 (Location)
SEO: Search Engine Optimization

Search Engine Optimization is the process of improving the traffic to your site via Search Engines like Google.

**sub page ]**

See child page.

**upload ]**

To transfer data, files, or programs from a local computer or device to a server.

**WYSIWYG editor ]**

“What You See Is What You Get”; a content editing interface that allows site editors to apply advanced formatting using a Microsoft Word-type menu bar. This tool allows users with no HTML knowledge to edit fonts, alignment, hyperlinks and input images within their textual content.

**Iconography**

Note that not all users will see all icons. Some icons are only seen by site administrators.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add" /></td>
<td>Add: add a new page, module entry, or user.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete: delete a page, module entry, or user.</td>
</tr>
<tr>
<td><img src="image" alt="View All" /></td>
<td>View All: not yet available.</td>
</tr>
<tr>
<td><img src="image" alt="Unarchive" /></td>
<td>Unarchive: reinstate page into navigation.</td>
</tr>
<tr>
<td><img src="image" alt="View" /></td>
<td>View: View items in a category.</td>
</tr>
<tr>
<td><img src="image" alt="Approve" /></td>
<td>Approve: approve a change; approved content.</td>
</tr>
<tr>
<td><img src="image" alt="White Page Icon" /></td>
<td>White Page Icon: user has access to current page only.</td>
</tr>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Preview: view draft version of a page.</td>
</tr>
<tr>
<td><img src="image" alt="Close" /></td>
<td>Close: close tool tip.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>Edit: edit a page, module entry, or user.</td>
</tr>
<tr>
<td><img src="image" alt="Reorder" /></td>
<td>Reorder: drag-and-drop ordering of navigation items.</td>
</tr>
<tr>
<td><img src="image" alt="Archive" /></td>
<td>Archive: remove page from navigation.</td>
</tr>
<tr>
<td><img src="image" alt="Hidden" /></td>
<td>Hidden: page is not visible/accessible via navigation.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search: signifies search field.</td>
</tr>
<tr>
<td><img src="image" alt="Tree Access" /></td>
<td>Tree Access: user has access to current page and each subsequent child page.</td>
</tr>
<tr>
<td><img src="image" alt="Blue “No” Sign" /></td>
<td>Blue “No” Sign: unapprove; no access; not recurring.</td>
</tr>
<tr>
<td><img src="image" alt="Deny Change" /></td>
<td>Deny Change: deny; deletes pending change.</td>
</tr>
<tr>
<td><img src="image" alt="View Entry" /></td>
<td>View Entry: view changed entry.</td>
</tr>
</tbody>
</table>
Basic Usage

Overview

When you first log into BigTree, you will see the Overview page. This landing page serves as the jumping-off point.

Navigation

You will notice tabs at the top of the page for the Pages and Modules areas in BigTree. These tabs are part of BigTree’s consistent navigation; they will always be present on the page for your use in navigating the site. The Users and Super Admin tabs will not be seen by most users.

Header

The header of the Overview page and each successive BigTree page will display consistent tools. They are found in the upper right corner of the screen.

- **Log-out:** Allows users to log out of a secure session in BigTree from any page.
- **View University of Puget Sound Site:** Opens the “front end” of your site in a new browser window.
- **Search Pages:** Live search found within the navigation bar; allows the user to quickly and easily find and navigate to pages within the site.
Quick Links

The Quick Links section allows the user to search and save links to frequently-accessed pages. Just start typing your page name in the Quick Links search field and a list of pages will appear.

Clicking the green icon next to any of the resulting page links will add a Quick Link to the list on the Overview landing page. That link will appear each time that user logs in for quick access to that saved page, much like “Favorites” or “Bookmarks” in a Web browser.

These links can be deleted by clicking the red “X” icon. Clicking the yellow pencil icon will allow the user to edit the page.
The **Pages** section controls the majority of the content on your Web site. **Pages** is set up based off of the information architecture for the site, which organizes your content into cascading levels of information. This is also known as a “navigation tree” because your site’s content branches out from main level or primary pages to the successive sub or child pages:

- **Primary (Main Navigation)**
  - **Secondary (Sub Page or Child Page)**
    - **Tertiary (Sub Page or Child Page)**
    - **Quaternary (Sub Page or Child Page)**

The **Pages** landing page lists the **Main Level Navigation**, which are the primary categories under which all content in your site fall. Also listed here are:
• **Hidden Pages**: Pages not visible on the front end in the navigation, but can be directly linked from other pages in your site

• **Archived Pages**: Pages that are not visible in the navigation and not live, but are most likely being developed or saved for future use.

BigTree also provides hints and tool tips to remind users about functionality and iconography being used in certain sections. Click the “X” in the upper right corner of the message to close it.

---

**Navigating Pages**

- Starting at the **Main Navigation Level**, click on a page title to display its child pages.
- Click on a child page’s title to display its child pages and so on until you’ve reached the page you’re looking for.
- The URLs and breadcrumb navigation on the front end of your site will give you clues to the “path” you need to take to find and edit a page in the CMS.

**Example**

- **URL**
  
  http://www.parksandpeople.org/greening/grants/how-to-apply/

- **Breadcrumb Navigation**
  
  Home » Greening » Grants » How to Apply

To edit this page on how to apply for a grant, a user would go to:

- **Pages**
  - Click **Greening** under **Main Level Navigation**
  - Click **Grants**

  Click the **Edit** icon next to **How to Apply**
In this example screen, we are viewing the page children of **Grants**:

To go back or “up” a level in the navigation tree, either click the browser’s “back” button or click on the link “< **Greening**”; this will take you back to the screen listing the **Greening** page children.

**Adding Pages**

Users can add pages to any navigation level within their site’s “tree” (that they have permission to access) by clicking the round green **Add** icon. The icon is usually found at the top left of the page listing. The text next to the icon will tell you exactly where you will be adding your new page—**Add New Page To [Page Title]**.

The page you add will become a child or sub page of that page. In this example, **Trails**:

- Click the green **Add** icon to **Add New Page to Trails**
• **Step One: Navigation**

  Home > Parks > Trails

  **Add Page**

<table>
<thead>
<tr>
<th>Navigation</th>
<th>Template</th>
<th>Content</th>
<th>SEO</th>
<th>Access</th>
</tr>
</thead>
</table>

  **Navigation Title**
  
  *My Page*

  **URL Route** *(leave blank to auto generate)*
  
  *my-page*

  - Visible in Navigation

  Next Step

  • Give your new page a **Navigation Title**. This is the name that appears in the site navigation.

  • Give your new page a custom **URL Route**; if you want BigTree to generate the URL automatically, leave the field blank. It’s generally recommended to let BigTree generate the URL, unless you want something specific, like an acronym. If the generated URL is too long or cuts off in a way you dislike, you can always come back in and alter the URL.

  • **Visible in Navigation** is checked by default; if you want your page to be excluded from display in the navigation list on the front end, uncheck this box. This will make the page appear in the **Hidden Pages** section for that level of the site.

  • Click the **Next Step** button.
• **Step Two: Template**

![BigTree User Manual](image)

- **Enter your Page Title.** As you can see from the graphic above, the Page Title appears at the top of the browser window. The page title is also useful for search engine optimization.

- **Choose your Page Type.** BigTree provides three types of pages to choose from; you can select only one type from the three groups—Page Template, Module Template, and Page Link.
  - Page Templates are pre-designed layouts for basic WYSIWYG-driven content that give you several options for the look of a page without breaking with the conventions of your site’s design. You’re almost always going to select one of the first two templates: Content or Content-Slim.
Module Templates are templates that pull in specifically-programmed data and layouts from content entered via BigTree’s Modules section. Most users will not need any of these module templates.

Page Link gives the user an option to create a page that links directly to another page. For instance, if you want an item in your page’s navigation box that points to a page in another area of the site, you would use a Page Link. (E.g., School of Music may need link in their navigation about Admission that actually opens a page in the Admission site)

- **External Link**: A link to a page outside your section of the site or to another site altogether. It is recommended to have External Links open in a new window to keep users from straying too far from where they were browsing within your site. If you need the link to open in the existing browser window, select No from the Open New Window? drop down menu.
- **Redirect Lower**: Link to the page’s next most immediate child page. This is only used in very special cases. Contact the Web Manager before using this option.

Click the Next Step button.

### Step Three: Content

Give your new page a **Page Header** that will appear at the top of the content area. The Page Header uses the “h1” tag in HTML, another area of high-value content for SEO purposes. There is only one h1 tag allowed per page, so make sure yours is richly descriptive.
Note: Often the **Navigation Title** you entered on the Navigation tab, the **Page Title** you entered on the Template tab, and this **Page Header** entered on the Content tab are the same or similar. However, each serves a specific purpose, so it’s important to enter all three. Separating these three values allows you the flexibility to enter slightly different values for these three page titles if needed.

- Use the **WYSIWYG** editor to enter the content for your new page. **WYSIWYGs** work much like the common word processing program, Microsoft Word. True to its name, what you see within the editing screen is basically what you get on the front end of your site. You can also paste in content from an external source.

- **Photo Gallery** gives users the option to add a photo with a caption. Clicking “SHOW” expands the window to allow you to upload an image from your computer. Note that this will allow you to enter images directly from your computer without working through the Web Manager as in the past. Be aware that copyright laws are still in effect, so be sure you have permissions for any image you use. Users should also strive to put only good, quality images on the site.

- **Related Pages** gives users the option to add link to a **Related Page** within the site or on an external site. Clicking “SHOW” expands the window to allow you to enter a URL and set your new window preferences.

- **Contact Information** allows you to enter information in one or two columns. If you’re using a template that has a wide right-side column, your contact information will appear in two columns as shown. If you’re using a template that has a narrower right-side column, your contact information will appear in a single column.

- **Feature** fields allow you to control the special feature box that you can add to the top of pages using the standard templates (such as Content or Content-Slim). You can add up to three features including title,
limited text, high quality image (required), and a link for additional information. You can also control the color of the feature box. If the feature information is left blank, the box will not appear on your page.

- **Step Four: SEO**

  - **Add Meta Keywords**
    
    Meta Keywords are lists of comma-separated words that should be descriptive and unique to what your company is about; 25 words is the recommended limit for SEO purposes, but you can have as few or as many words as you like in this field. Standard Keywords include your company name along with words specific to the expertise you're providing on that particular page.

  - **Add Meta Description**
    
    The Meta Description is a sentence or two describing the page’s content. The maximum recommended number of characters for a Meta Description is 250. Rich keywords, specificity to content on the page, and overall readability is key for this field. This is the most likely field to be displayed as a search result on both your internal site search and via search engines like Google and Yahoo. It is a proven fact that users are more likely to click on a properly-capitalized and well-punctuated sentence description rather than a string of uncapsalized keywords.

  - Click the **Save & Publish** button to make publish the new page live to your site.

  - Click the **Save** button to save a draft of your new page.
**Editing Pages**

To edit an existing page in your site’s tree, navigate to the page and click its yellow pencil **Edit** icon. Similar to adding a page, the editing options for each page follow the same steps; a user can change:

**Navigation tab**
- Navigation Title
- URL Route

**Template tab**
- Page Title
- Page Type
  - Page Template
  - Module Template
  - Page Link

**Content tab**
- Page Header
- Page Content
- Photo Gallery
- Related Pages

**SEO tab**
- Meta Keywords
- Meta Description

See the **Detailed Usage** section of this manual for in depth information on controlling your **Page** content.

**Archiving & Deleting Pages**

BigTree’s system of **Archiving** and **Deleting** pages is meant to protect users from accidental content deletion. It is for this reason that true deletion of pages is actually a two-step process. The user must first **Archive** the file, then choose to **Delete** it.

An **Archive** is defined as a collection of historical documents or records; BigTree’s archival system serves just that purpose. If a user wishes to remove a page of content from the front end, but store it for future reference or use, the **Archive** function should be used.

To **Archive** a page, the user should simply click the blue zippered folder icon in the **Pages** list view. The page will automatically be moved to a lower portion of the page under the heading **Archived Pages**. The page will disappear from view and access via navigation on the front end.
Later, if the user wishes to Unarchive the page, he or she must simply click the Unarchive icon, which is the blue zippered folder with an arrow. The page moves back into the list of active pages and is reinstated on the front end as visible and accessible through the navigation.

To completely Delete an Archived page, the user should simply click the red “X” Delete icon. As a final safety measure, users are prompted with a message: “Are you sure you want to delete this page? This data cannot be recovered.” You must click “OK” before a page is completely Deleted. Users are encouraged not to delete anything when first using the BigTree CMS; just archive it.

Moving & Reordering Pages

BigTree allows great flexibility in organizing site content. Users can move pages throughout a site and reorder navigation quickly and easily. To ensure site integrity, BigTree automatically repairs any internal links to moved pages to reflect new page locations to eliminate broken links within your content.

Page moves can be simple (up or down one level within the same main section) or complex (moved to an entirely different section of the site). To Move a page, contact the Web Manager.

You can Reorder how navigation is displayed on the front end by simply clicking and dragging the four-arrowed Reorder icon to the left of each page title in the Pages list view.

Detailed Usage

WYSIWYG

The most common tool used to manage content in BigTree is the open WYSIWYG editor. This tool is the basis of the Pages section in BigTree as it is the way you control your site’s content. You can find the WYSIWYG editor for your Pages in the Content tab of the Add Page or Edit Page view.

The WYSIWYG works like a word processing application; it allows input, layout, and formatting of text and images to create a page—in this case, a Web-based page instead of a printable document.

Adding Text

Text can be added to a WYSIWYG by typing directly into a page or by copying and pasting content from another source.

The WYSIWYG has a toolbar with a variety of formatting options to help you quickly edit your content. These controls will probably look familiar if you have ever used Microsoft Word or an e-mail program like Microsoft Outlook.
Icon Key

<table>
<thead>
<tr>
<th>B</th>
<th>Bold</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>HTML View</td>
</tr>
<tr>
<td></td>
<td>Align Center</td>
</tr>
<tr>
<td></td>
<td>Align Full</td>
</tr>
<tr>
<td></td>
<td>Numbered List</td>
</tr>
<tr>
<td></td>
<td>Remove Link</td>
</tr>
<tr>
<td></td>
<td>Insert/Edit Image</td>
</tr>
<tr>
<td></td>
<td>Undo</td>
</tr>
<tr>
<td>I</td>
<td>Italic</td>
</tr>
<tr>
<td></td>
<td>Align Left</td>
</tr>
<tr>
<td></td>
<td>Align Right</td>
</tr>
<tr>
<td></td>
<td>Bulleted List</td>
</tr>
<tr>
<td></td>
<td>Insert/Edit Link</td>
</tr>
<tr>
<td></td>
<td>Anchored Link</td>
</tr>
<tr>
<td></td>
<td>Horizontal Rule</td>
</tr>
<tr>
<td></td>
<td>Redo</td>
</tr>
</tbody>
</table>

Helpful Hints

- To avoid strange formatting errors, always try to paste plain text content into your **WYSIWYG** when copying and pasting.

- **Microsoft Word**: Content originating from Microsoft Word can sometimes inherit formatting and styles that are not Web-friendly. When in doubt, convert Word documents to plain text before copying and pasting directly to a **WYSIWYG**.
  
  **Option One**:
  
  - Open the document in Word
  - Go to File>Save As
  - Select “plain text” from the “Save as type” drop down menu
  - Click “Save”. The file will be saved with a .txt extension

  **Option Two**:
  
  - Open the document in Word
  - Choose “Select All”
  - Choose “Copy”
  - Open TextEdit, Notepad, or TextPad
  - Paste the content into the new window
  - Click “Save”. The file will be saved with a .txt extension

- **TextEdit, Notepad, or TextPad**: Content originating from these applications tend to have a .txt extension and are most likely already plain text.

Keystrokes & Mouse Tricks

| Select All | Ctrl + A (PC) Command + A (Mac) | Menus: Edit>Select All Mouse: Right Click>Select All |
| Cut        | Ctrl + X (PC) Command + X (Mac) | Menus: Edit>Cut Mouse: Right Click>Cut |
| Copy       | Ctrl + C (PC) Command + C (Mac) | Menus: Edit>Copy Mouse: Right Click>Copy |
| Paste      | Ctrl + V (PC) Command + V (Mac) | Menus: Edit>Paste Mouse: Right Click>Paste |
Link Search

Much like the Search Pages feature in BigTree’s navigation bar, Link Search is a live search that allows the user to quickly and easily find pages within the site to which they want to link.

- Begin typing a query for the page you wish to link to
- Find the item in the list of suggested pages
- Drag-and-drop the link into the WYSIWYG to create a hyperlink to that page
- You are able to edit the blue link text in the WYSIWYG editor as you would any other text
- With your cursor on the new link, click the Insert/Edit Link icon for more options such as setting the link target and title

Helpful Hint

As an alternative to dragging-and-dropping links into your content, you can:

- Right click the link
- Choose “Copy Link Location” from the menu to copy the URL
- Paste the URL where needed (see Adding Hyperlinks)

Adding Hyperlinks

There are two additional ways to add a hyperlink within your page content to either a page within your site or an external URL.

Option One

- Highlight the text you wish to link
- Click the Insert/Edit Link icon
- Type or Paste the URL into the “Link URL” field
- Select the target from the “Target” drop down menu
  - Select “Open in new window (_blank)” for external links
  - Select “Open in this window/frame” for internal links
- Give your link a title, if needed, in the “Title” field. This will be visible when you hover your mouse over the link text on the front end and is a good SEO practice.
- Click “Insert” to finish

Option Two

- Click the HTML View icon
- Find the text you wish to link
- Add the link using the following format/code
  - Internal link opening in same window
    `<a href="http://www.your-url.com">This is link text</a>`
  - External link opening in a new window
    `<a href="http://www.their-url.com" target="_blank">This is link text</a>`
Click “Update” to save your changes

**Resources Toolbar**

The **Resources Toolbar** is a feature of BigTree that enables you to upload images and documents for use in linking and embedding in your content. It is located on the right side of the page in the **Edit Page** view. (You will not see the Resources box in the Add Page view.)

**Upload a New Resource**

- Click the **Upload New Resource** button. (If you don’t see a button, contact the Web Manager.)
- A dialogue box should open to allow you to browse your computer for files (.pdf, .doc, .jpg, .png, .gif, xls, and .ppt files are supported by BigTree)
- Click the file you wish to upload.
- Click the **Select** button.
- The file will now appear in the toolbar.
  - Images appear as thumbnails
  - Files are listed by file name

**Find an Existing Resource**

The **Resources Toolbar** also allows the user to search for items that may already be uploaded to the site. To find an existing resource, use the drop down menus below the “**Show:**” heading in the toolbar.

The drop down choices allow for the following combination searches:

- All + On This Page
- All + On All Pages
- Images + On This Page
- Images + On All Pages
- Files + On This Page
- Files + On All Pages

**Deleting Resources**

Clicking the red “X” icon next to any item in the **Resources Toolbar** will delete that item. This does not delete that item from the page content. You must delete that separately.

**Adding Images**

Like hyperlinks, there are a few options you can use to add an image to the content within the **WYSIWYG**.

**Note:** Before you upload a file please note that file names should not include spaces or `%20`. Rename your files before uploading if your file name contains these characters.

**Option One**

- Upload an image to the **Resources Toolbar** or find the existing image you wish to use
Click the image in the toolbar list
Drag-and-drop it to the WYSIWYG window
With the image selected, click the Insert/Edit Image icon for more options such as image layout and text wrapping

Option Two
Upload an image to the Resources Toolbar or find the existing image you wish to use
Right click the image
Choose “Copy Image Location” from the menu
Place your cursor where you’d like the image to be inserted within the WYSIWYG
Click the Insert/Edit Image icon
A dialogue box should open to the default “General” tab
Paste the copied image URL into the “Image URL” field
Add an image description to the “Image description” field, if desired. The description field is often used for SEO purposes, as well as accessibility purposes.
Add a title to the “Title” field, if desired. This will be visible when you hover your mouse over the image on the front end and is also used for SEO.
Click the “Appearance” tab to set the...
  Alignment
  Vertical space
  Horizontal space
  Border
  Style
Click “Insert” to finish

Adding Documents
Adding links to downloadable documents is achieved through the use of the Resources Toolbar and the information you learned in the Adding Hyperlinks section.

Note: Before you upload a file please note that file names should not include spaces or %20. Rename your files before uploading if your file name contains these characters.

Option One
Upload a file to the Resources Toolbar or find the existing file you wish to use
Click the file name in the toolbar list
Drag-and-drop it to the WYSIWYG window to create a hyperlink to the file
You are able to edit the blue link text in the WYSIWYG editor as you would any other text
With your cursor on the new link, click the Insert/Edit Link icon for more options such as setting the link target and title

Option Two
Upload a file to the Resources Toolbar or find the existing file you wish to use
Right click the file name
Choose “Copy Link Location” from the menu
- Highlight the text you wish to link
- Click the Insert/Edit Link icon
- **Type or Paste** the URL into the “Link URL” field
- Select the target from the “Target” drop down menu
  - Select “Open in new window (_blank)” for external links
  - Select “Open in this window/frame” for internal links
- Give your link a title, if needed, in the “Title” field. This will be visible when you hover your mouse over the link text on the front end and is a good SEO practice.
- Click “Insert” to finish

**Notes**

*Notes* is the yellow section at the top of the Edit Page view where the site administrator may have made notes about the content on the page, such as indicating that it should not be altered without permission.